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1 Allmänt 
Detta dokument innehåller anvisningar för handhavande av mallpaketet FMV 
Produktionsmiljö 3 Bokpublikationer. 
Mallarna i paketet är i formatet FrameMaker. Handhavande som är specifikt 
för mallarna tas upp i detta dokument. 
Användare av mallpaketet förutsätts ha grundläggande kunskaper i: 
• 
• 

Arbete med strukturerade dokument i FrameMaker 
Regelverk FMV Materielpublikationer 

Hanteringen av malldokumenten skiljer sig beroende på vilken typ av 
malldokument det handlar om. 

Mallarna är vanliga FrameMaker dokument utan någon struktur från någon 
EDD. Strukturen är ej nödvändig för att kunna skapa önskat utseende för 
skärmbildspresentation, ej heller för framtidssäkring då de strukturerade 
dokumenten kan innehålla tillräcklig information för detta. 
Till en publikation kan följande läggas till: 
• 
• 
• 
• 

Genererade listor som innehållsförteckning, index, etc 
Titelblad 
Försättsblad 
Omslag 

Innehållsförteckning och index kan genereras direkt från dokumenten med ett 
fungerande utseende. 
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OBSERVERA 
Arbete med dokument av typen inlaga kräver att det 
strukturerade gränssnittet är påslaget i FrameMaker för att inte 
förstöra dokumenten som en gradering. 



2 Ladda ner malldokument 
På FMV's Logistikportal finns alla mallar som FMV tillhandahåller. 
Malldokumenten finns tillgängliga på Logistikportalen i formatet MIF, ett 
format som kan läsas av alla versioner av FrameMaker. 
Använd FrameMaker version 12 eller senare för att inte förlora några 
egenskaper i mallarna. 
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3 Malldokument - Inlaga 
Inlagan är ett strukturerat dokument enligt Enkeldok DTD och måste därför 
hanteras i FrameMaker med det strukturerade gränssnittet påslaget för att inte 
förstöra dokumentet. flera funktioner i mallen utnyttjar strukturen och skulle 
inte fungera utan denna. 
Anvisningarna nedan tar upp de delar av EnkelDok DTD som används 
specifikt i mallarna vilket innebär att det finns element och attribut som 
lämnas utan kommentarer. 

3.1 Rotelementet datamodul 
Elementet Datamodul är inlagans s k rotelement. Detta element omsluter 
hela inlagans innehåll och innehåller de attributvärden som gäller hela 
dokumentet. 
Följande element kan användas under rotelementet Datamodul: 

Dokumentets titel 

Används för att kunna länka in en 
innehållsförteckning i dokumentet. 

Element för uppmärksamhetstexter. För mer 
information om dessa se 3.6 Uppmärksamhetstexter 
sida 16. 

Avsnitt i dokumentet på den översta 
beskrivningsnivån, se även element Avsnitt nedan. 

Avsnitt i dokumentet som inte är bundet till vilken 
nivå avsnittet är placerat. Kan användas istället för 
elementen Niv1-5. 

Titel 

Ih, Ihref 

Varn, Obs, Anm 

Niv1 

Avsnitt 

Ordningen för elementen under rotelementet är fast (enligt listan ovan). 
Däremot är det frivilligt att använda sig av dom. 
Elementet Datamodul innehåller ett stort antal attribut för placering av olika ty 
per av information i dokumentet. En del av dessa används för att bestämma ut 
seendet på dokumentet medan andra ger plats för information om dokumentet. 
Vissa av attributen hämtas av mallen till sidhuvud och sidfot. Dessa attribut har 
i regel fyllts med ett värde så att en användare lättare kan se var denna 
information syns i dokumentet. 
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3.1.1 Dokumentets format 
Utseendet på dokumentets innehåll styrs av flera attribut i rotelementet 
Datamodul. På detta sätt kan utseendet lätt ändras efter behov genom att byta 
värde på ett attribut. 
Ett värde behöver normalt vara satt i dokumentet för korrekt funktionalitet i 
dokumentet. 

Tabell 1. Attribut för styrning av funktionalitet och layout 
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Attribut Värde(n) Beskrivning 

Format 
 
 
 
 
 
 
 
 
 
Nivnum 
 
 
 
 
 
 
 
Nivplac 

 
 
 
 
 
 
 
 
Sprak 
 

A4ls34n 
A4ls2n 
A4hs34n 
A4hs2n 
A5ls1n 
A5hs1n 
A3ls134n 
 
 

 
Ingen 
R03 
R13 
R05 
R15 
R15s1 
 

 
N1tf25f 
N15f 
N13f45c 
N1tf23f45c 
N1tf25c 
N15c 
N1rtf25f 
 

 
Swe 
Eng 
 

Bestämmer utformningen på hela 
dokumentet. Finns för varje typ av 
strukturerat malldokument. 
Detta attribut används för att skilja mellan de 
olika dokumenttyperna då dessa använder 
samma EDD i produktionsmiljön. 
För mer information om attributet Format 
se 8 Uppdatera dokumentet enligt ny mall 
sida 25. 

Val av rubrik och styckenumrering: 
R<start><antal>[S] 
<start>: Startsiffra på nivå 1 
<antal>: Antal rubriknivåer 
R = rubriknumrering 
S = styckenumrering 

Bestämmer placeringen av rubriker för olika 
beskrivningsnivåer. 
Siffrorna hänvisar till rubriknivåerna. 
r: Höger (right) 
t: Överst i textram eller kolumn 
f: i textram(frame) 
c: i kolumn (column) 

Val av språk i dokumentet för styrning av 
avstavning och genererade texter i 
dokumentet. 

 



3.1.2 Information om dokument och objekt 
Attributen i tabellerna nedan används för information om dokumentet och det 
eller de objekt som dokumentet beskriver. Det är normalt valfritt att använda 
dessa attribut men vissa av dom behöver ett värde ifall värdet ska synas i t ex 
sidhuvudet. 

Tabell 2. Attribut för information om dokumentet/publikationen 
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Attribut Värde Beskrivning 

Doktitel 

Pubtitel 

Faststdat 

Datum 

Pubtyp 

Fben 

Fbet 

Pubfastst 

Ansv 

Sakhandl 

Teknuhs 

Pubdel 

 
Pubflik 
 

<text> 

<text> 

<text> 

<text> 

 
<text> 

 
<text> 

 
<text> 

 
<text> 

<text> 

<text> 

<text> 

<text> 
 

 
<text> 
 

Dokumentets/flikens fullständiga titel 

Publikationens fullständiga titel 

Fastställelsedatum 

Datum för utgivning av dokument/ 
publikation 

Typ av publikation, t. ex. MVIF, 
Vårdsystem 80 

Publikationens förrådsbenämning, t. ex. 
ROSKSCH STRV 203 

Publikationens förrådsbeteckning, t. ex. 
M7782-998677 

Publikationsbeslutsnummer 

Ansvarig för dokumentet, t. ex. FMV 

Sakhandläggare 

Tekniskt underhållsstöd 

Del (pärm) av en publikation, t. ex. Del 1, 
Del 2. attributet lämnas tomt om 
publikationen endast består av en del 

Flik i publikationen, t. ex. Flik 1, Flik 2, 
attributet lämnas tomt om publikationen 
inte är uppdelad i flikar 

Attribut Värde(n) Beskrivning 

Andr
- 
ma k 

Inga 
alla 

Bestämmer om ändringsmarkering ska visas 
eller ej 

 



3.1.3 Information om objekt 
Tabell 3. Attribut för information om det beskrivna objektet 

3.2 Beskrivningsnivåer 
För uppdelning i beskrivningsnivåer används elementen Niv1, Niv2, Niv3, 
Niv4 och Niv5 eller enbart elementet Avsnitt. 
Niv2 kan placeras i Niv1, Niv3 kan placeras i Niv2, etc, medan elementet 
Avsnitt kan nästlas obegränsat antal gånger. I mallarna finns endast stöd för 5 
nivåer oavsett vilket avsnittselement som används. 
Varje beskrivningsnivå kan innehålla följande: 
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Attribut Värde Beskrivning 

Uhobj 

Kod 

Matrobj 

Matrgrp 

Matrugrp 

Lopnr 

<text> 

<text> 

<text> 

<text> 

<text> 

<text> 

Underhållsobjekt 

Kod, MIMI-kod 

Materielobjekt 

Materielgrupp 

Materiel undergrupp 

Löpnummer 

Attribut Värde Beskrivning 

Lev 

Distr 

Levref 

Utgbet 

Arbutgbet 

Sekretess 

Andrenl 

 
Upphaver 
 

<text> 

<text> 

<text> 

 
<text> 

<text> 

O|H|Kh 

<text> 

 
<text> 
 

Leverantör av publikationen 

Varifrån ytterligare exemplar kan beställas 

Plats för referenser för det producerande 
företaget: Företagsnamn, filnamn etc. 

Revisionsnivå. 

Revisionsstatus 

Sekretessgrad: Ej hemlig, Hemlig eller 
Klassificerat hemlig 

Avsett för användarens uppföljning av 
ändringar 

Dokument som upphävs av detta dokument 
(ett eller flera) 

 



avsnittets titel 

element för uppmärksamhetstexter. För mer 
information om dessa se 3.6 Uppmärksamhetstexter. 

den egentliga brödtexten 

numrerad lista, se 3.5 Listor 

en punkt-lista, se 3.5 Listor 

för att skapa en tabell, se 3.4 Tabeller 

för placering av en bild i dokumentet, se 3.3 Bilder 

gör det möjligt att lägga in en sidbrytning i 
dokumentet. 

innehåller ett avsnitt i dokumentet på nästa 
beskrivningsnivå (x=2, 3, 4 eller 5). 

Rubrik 

Varn, Obs, Anm 

Text 

Lista-num 

Lista-punkt 

Table 

Bild 

Sidbryt 

Nivx 

Elementet Rubrik måste placeras först på en specifik beskrivningsnivå. 
Element för en lägre beskrivningsnivå, Niv2, Niv3, etc. måste placeras sist. De 
övriga elementen kan läggas in däremellan i godtycklig ordning och i valfritt 
antal. 

3.3 Bilder 
För hantering av bilder används följande element: 

rotelementet för en bild 

bildelement som innehåller en referens till den bild 
som är länkad in i dokumentet 

ett valfritt extra element för flexiblare placering av 
bildelementet Bild-data 

Bild 

Bild-data 

Bild-plats 

Bild-poslista för beskrivning av utmärkta positioner i bild. se 
3.3.3 Lägga till positionsbeskrivning 

plats för bildtitel Bild-rubrik 

Elementet Bild kan innehålla elementen Bild-data (alt. Bild-plats), 
Bild-poslista samt Bild-rubrik. Elementen, en av varje, kan 
placeras i valfri ordning. 
Elementet Bild-data kan placeras direkt under Bild eller omslutet av 
elementet Bild-plats som i sin tur ligger direkt under Bild. 
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Elementet Bild-data kan även placeras direkt i olika styckebaserade element 
för att på så sätt ge möjlighet att lägga in ett bildobjekt direkt på textraden. 

3.3.1 Inlänkning av bild 
En bild kan sättas in nästan överallt i dokumentet, även i tabell. Vid 
insättningen utnyttjas den inbyggda funktionen för import av bild som 
aktiveras vid insättning av elementet Bild. 
1 
2 

Placera insättningspunkten på giltig plats för bild. 
Sätt in elementet Bild. 
Dialogrutan Import File visas. 
Välj bildfil som ska länkas in. 
Sätt in elementet Bild-poslista om så önskas. 
Sätt in elementet Bild-rubrik om så önskas. 

3 
4 
5 

För mer information se: 
• 
• 

3.3.2 Placering av bild sida 9. 
3.3.3 Lägga till positionsbeskrivning sida 10 

3.3.2 Placering av bild 
Bildens placering kan ändras i förhållande till den text den är kopplad till. I 
valet ingår att bestämma om elementet Bild-plats ska användas eller inte 
samt att sätta attributet Bredd under elementet Bild. 
Produktionsmiljön stödjer även en del av funktionerna för kopplad ram som 
placering i texten, justering i sidled samt vertikalt avstånd i förhållande till 
placering i texten (gäller endast då bilden är placerad i marginalen). 
1 Sätt in elementet Bild-data i elementet Bild-plats om så önskas 

Detta gör det möjligt för en mer flexibel placering av bilden i texten. 
Ställ in önskad placering, justering samt offset för kopplad ram. 
Detta ställs in under Special > Anchored Frame... under huvudmenyn. 
Sätt attributet Bredd under elementet Bild till önskat värde enligt 
tabellen nedan. 

2 

3 
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OBSERVERA 
Med nuvarande version av Structured FrameMaker 
rekommenderas att bilder sparas i samma mapp som 
textdokumenten då Structured FrameMaker ej ännu hanterar 
relativa sökvägar på ett bra sätt. 



Tabell 4. Attributet Bredd under elementet Bild 

 

3.3.3 Lägga till positionsbeskrivning 
I de fall där utpekningar i en bild är gjord med siffror (poser) kan en lista med 
beskrivningar på dessa läggas till under elementet Bild. 

Bild-poslista lista med beskrivningar på utmärkta poser i en bild 

beskrivning på en pos Bild-pos 

Bestämning av pos i elementet Bild-pos görs med attributet Pos. 

Tabeller 
Vid insättning och hantering av tabeller i Structured FrameMaker, utnyttjas 
den inbyggda tabellfunktioner för detta. 
Elementstrukturen för Table är: 
Table: (Title?, Tgroup, Tabnoter?) 

De olika elementen används till följande: 

3.4 

rotelementet för tabell 

tabelltitel 

den egentliga tabellen 

markerar innehållet för varje cell i tabellen 

Table 

Title 

Tgroup 

Entry 
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Attribut Värde Beskrivning 

Bredd 
 

"Spalt" 

"Fullbredd" 

"Marginal" 

"Dubbel" 

"Kolumn" 

över alla kolumner 

över hela satsytan 

i marginal men inom satsytan 

används ej i produktionsmiljön 

i kolumn 

 

OBSERVERA 
Använd originalstorlek på bilderna. 
Skalning av bilder stöds ej vid export till XML. Skala därför 
inte om inlänkade bilder i Structured FrameMaker. 



Det finns ytterligare element i en tabell som t.ex. Tbody, Row, etc. Dessa 
hanteras dock automatiskt av Structured FrameMaker. 
Elementet Title är valfri. Elementet Tabnoter är en konstruktion för att 
kunna placera fotnoter under en tabell i tidigare versioner av DTD’n. I 
produktionsmiljön används dock istället elementet Fotnot i och utanför 
tabeller för att skapa fotnoter. 
I tabellcellen (Entry) går det att skriva in text direkt. Om ett mer komplext 
innehåll ska föras in går det istället att använda elementen Text, List-
punkt, Lista-num samt Bild. 
För mer information, se: 
• 
• 
• 

3.4.1 Insättning av tabell sida 11. 
3.4.3 Justering av text i celler sida 14. 
3.4.2 Placering av tabell sida 14. 

3.4.1 
1 
2 
3 
4 

Insättning av tabell 
Placera insättningspunkten på giltig plats för tabell. 
Sätt in elementet Table. 
Sätt in en tabelltitel om en sådan önskas med elementet Title. 
Sätt därefter in elementet Tgroup. 
Dialogfönster Insert Table öppnas där val av antal rader och kolumner 
samt tabelltyp kan göras. 
Sätt in lämpliga värden för tabellformat, antal kolumner, rader i tabellen, 
rader i tabellhuvud etc. 
Ett valt tabellformat bestämmer endast om och var linjer ska finnas i 
tabellen samt linjetjocklekar. 

5 

Tabell 5. Tabellformat 
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Tabellformat Beskrivning 

Tabell-enkel 

Tabell 

Tabell-kompakt 
 

Enkelt utförande med endast horisontella linjer för 
att indikera en tabell 

Normalt utförande på en tabell. Ram runtom och 
linje mellan varje kolumn 

Samma utförande som valet Tabell. Detta val 
användes i version 1.0 för att få mindre avstånd till 
tabellcellens kanter. Nu styrs detta av EDD’n 

 



6 Sätt attributet Tabstyle under elementet Table för att bestämma 
styckeutformningen i tabellcellen. 
Med detta attribut bestäms fontstorlek, styckeavstånd samt avstånd till 
cellkanter i tabellcellen. 

Tabell 6. Attributet Tabstyle under elementet Table 
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Attribut Värde Beskrivning 

Tabstyl 
e 
 

"Text- 
kolumner" 

 
"Enkel" 
 
 

 
"Normal" 
 

 
"Kompakt" 
 

Ger samma storlek på det använda 
typsnittet som på den omgivande texten. 
Inget avstånd till vänster cellkant. 

Samma utförande som för värdet 
Normal. Detta val användes i version 1.0 
för att passa till tabellformatet Tabell-
enkel. 

Ger normalt ett typsnitt på -1 punkters 
storlek i förhållande till den omgivande 
texten. 

Ger en tabell med storlek på typsnitt på 
normalt -3 punkter mot den omgivande 
texten. 
Avstånd till cellkanterna har också 
minskats. 

Tabellformat Beskrivning 

Text-kolumner 
 

Tabell utan ram och linjer, används där endast en 
uppdelning av texten i kolumner önskas. 

 

OBSERVERA 
Värdet på attributet Tabstyle behöver inte nödvändigtvis 
överensstämma med det använda tabellformatet. 

OBSERVERA 
Använd de tabelltyper i dialogrutan Insert Table som 
benämns med versal-gemen text (ex. Tabell-kompakt). 
Tabelltyper med versal text (ex. TABELL-KOMPAKT) har  
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OBSERVERA (forts.) 
lagts till p.g.a. att benämningar på tabelltyper hanteras fel i 
Structured FrameMaker vid import/export XML. 



3.4.2 Placering av tabell 
Tabellen kan placeras på olika sätt i texten. Med attributet Bredd går det att 
ta hänsyn till hur bred en tabell är, se tabellen nedan. 

Tabell 7. Attributet Bredd under elementet Table 

 

3.4.3 Justering av text i celler 
Text i tabellceller kan justeras i sida med attributet Align samt höjd med att- 
ributet Valign under elementet Entry. 
1 
2 
3 

Markera den eller de celler i tabellen som ska ges en bestämd justering. 
Välj Element > Edit attributes... i huvudmenyn. 
Sätt önskat värde på attributet align eller Valign enligt tabellen nedan. 
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Attribut Värde Beskrivning 

Bredd 
 

"Spalt" 

"Fullbredd" 

"Kolumn" 
 

Tabell med titel är vänsterställd i text- 
spalten 

Tabell med titel är vänsterställd på 
satsytan 

Tabell med titel är placerad och centrerad 
i kolumn 

 

OBSERVERA 
Structured FrameMaker justerar själv automatiskt positionen 
av en tabell i kolumn, spalt eller satsyta beroende på 
storleken av tabellen. Detta bör dock undvikas då tabelltiteln 
beroende på malldokument kan placeras fel. 

OBSERVERA 
Structured FrameMaker stödjer ej användning av attributet 
"Orient" för att bestämma orientering av tabell på sidan. Om 
roterad tabell önskas, använd istället malldokument med 
liggande sida. 



Tabell 8. Attributet Align och Valign under elementet Tabell 

3.5 Listor 
Vid hantering av listor används följande element: 

rotelement för punktlista som i huvudsak används 
för uppräkningar 

rotelement för numrerad lista som i huvudsak 
används vid instruktioner där momenten ska göras i 
en bestämd ordning 

en del av lista med Lista-punkt eller Lista- 
num som rotelement 

text i lista, ingår i Lista-elem 

Lista-punkt 

Lista-num 

Lista-elem 

Lista-text 

Typ av lista väljs genom att sätta in rotelementet Lista-punkt eller 
Lista-num. Varje lista består av en eller flera element Lista-elem. För 
att kunna skriva in text måste därefter Lista-text läggas in. 
Det är möjligt att lägga lista i lista. Stöd med avseende på utseende finns för 
listor i två nivåer oavsett kombination. 
I strukturen för en lista kan ytterligare element läggas till. Rotelementet för 
respektive lista kan förutom Lista-elem även innehålla elementen Anm, 
Obs samt Varn, se 3.6 Uppmärksamhetstexter sida 16. Elementet Lista-
elem tillåter dessutom elementet Bild, se 3.3 Bilder sida 8. 
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Attribut Värde Beskrivning 

Align 
 
 
 
 
 

 
Valign 
 

"Left" 

"Right" 

"Center" 

"Justify" 

"Char" 

"Top" 

"Middle" 

"Bottom" 

Vänster 

Höger 

Mitten 

Rak vänster- och högermarginal 

Finns ej stöd för detta 

Högst upp 

I mitten 

Längst ner 

 



3.6 Uppmärksamhetstexter 
Uppmärksamhetstexter används när man vill göra användaren av 
informationen uppmärksam på viktig information. Det finns tre olika typer av 
uppmärksamhetstexter i produktionsmiljön: 
• 
• 
• 

Anmärkning 
Observera 
Varning 

3.6.1 Anmärkning 
En anmärkning används för att uppmärksamma viktig information för fortsatta 
instruktioner. 
Vid insättning av en anmärkning används följande element: 

Rotelement för anmärkning 

plats för textinnehållet i en anmärkning 

Anm 

Anm-text 

Vid insättning av elementen Anm, görs även en automatisk insättning av ele- 
menten Anm-text. 
Förutom text-elementen går det även att sätta in punktlistor med elementet 
Lista-punkt, se 3.5 Listor. 

3.6.2 Observera 
Observera används när risk för skador på materiel föreligger. 
Vid insättning av text av typ observera, används följande element: 

Rotelementet för observera 

textinnehållet i observera 

Obs 

Obs-text 

Vid insättning av elementet Obs, görs även en automatisk insättning av ele- 
menten Obs-text. 
Förutom text-elementen går det även att sätta in punktlistor med elementet 
Lista-punkt, se 3.5 Listor sida 15. 

3.6.3 Varning 
En varning används när risk för personskador föreligger. 
Vid insättning av en varning används följande element: 
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Rotelementet för varning 

tabellkroppen i varning 

en rad i tabellen (det finns bara en rad) 

en tabellcell dvs varningsrutan 

text i varningsrutan 

Varn 

Varn-body 

Varn-row 

Varn-cell 

Varn-text 

I Structured FrameMaker används tabellfunktionen för att kunna rama in en 
varning, dvs skapa en varningsruta. Detta har inneburit att de extra elementen 
Varn-body, Varn-row samt Varn-cell har lagts till i Structured 
FrameMaker för att detta ska fungera. I XML-format har däremot varning 
samma struktur som anmärkning och observera med elementen Varn samt 
Varn-text. 
I varningsrutan, dvs i elementet Varn-cell går det också att lägga till en bild 
med elementet Bild-data. Denna bild består oftast av en symbol som t.ex. 
en varningstriangel. För att varningsrutan ska få ett riktigt utseende med en 
inlagd bild, måste bildelementet omslutas av elementet Bild-plats. 

Insättning av en varning 
En varning sätts in enligt följande: 
1 
2 

Placera insättningspunkten på giltig plats för varningselementet. 
Sätt in elementet Varn från elementkatalogen. 
Dialogrutan Insert Table öppnas med tabellformatet Varningsruta 
markerad samt med en rad, en kolumn och inget huvud eller fot. 
Klicka på Insert. 
Sätt in elementet Varn-text. 

3 
4 

3.7 Hänvisningar 
Hänvisningar eller korsreferenser som de också kallas, läggs in i dokumentet 
med hjälp av referens-element. I mallpaketet för Bokpublikationer används 
följande referens-element: 
• 
• 
• 
• 

Ref avsnitt 
Ref-bild 
Ref-tabell 
Ref-moment 

Det förinställda formatet på respektive referens visar hela eller delar av det 
refererade objektet. Om så önskas, kan referensformatet bytas till en variant 
med sidhänvisning. 
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Referens- 
element 

Ref-avsnitt 

Destination Referens Referens med sida 

Rubrik 3.7.1 
Refererade 
objekt 

Bild 1 

Tabell 9 

2 

3.7.1 Refererade objekt 
sida 18 

Ref-bild 

Ref-tabell 

Ref-moment 

Bild-rubrik 

Title 

Lista-elem 

Bild 1 sida 18 

Tabell 9 sida 18 

2 sida 18 

3.7.1 Refererade objekt 
Detta avsnitt innehåller de refererade objekten. 

Bild 1. Bildexempel 

Tabell 9. Tabellexempel 

Instruktion med elementet Lista-elem i Lista-num: 
1 
2 

En första instruktion 
En instruktion till 
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3.8 Fotnoter 
En fotnot1 i den löpande texten läggs in med elementet Fotnot2. Om en fotnot 
önskas i en tabellcell, måste den placeras i elementet Text. 

Tabell 10. Tabell med fotnoter 

a. Text i tabellens första fotnot 
b. Text i tabellens andra fotnot 

Text till fotnot som är placerad utanför tabell, placeras alltid längst ned på 
samma sida som fotnotens nummer medan text till fotnot i tabell, alltid 
placeras direkt under tabellen. 

3.9 Framhävd och annan speciell text 
Text som ska framhävas märks med särskilda element. Produktionsmiljön 
omfattar följande element för utpekning: 

för markering av en del av texten 

gör texten upphöjd, t.ex. O2 

gör texten nedsänkt, t.ex. O2 

används för att märka ut ett eller flera ord av en viss 
typ, se tabellen nedan för tillgängliga val på dess 
attribut Typ 

Z-betoning 

Z-upp 

Z-ner 

Markord 

Elementen Z-upp och Z-ner samt Z-betoning tillåts överallt där text är 
tillåten. Markord måste placeras i elementet Text. 

Tabell 11. Attributet Typ under elementet Markord 

1. Kompletterande upplysning till ämnet med placering längst ned på sidan. 
2. Element i EnkelDok DTD 
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Attribut Värde Beskrivning 

Typ 
 

"Systemtext" Används till t.ex filnamn, 
elementnamn 

Kolumnrubrik   

 
Text med en fotnotb 

 Text med en fotnota 

 

 



3.10 Genererade listor 
Vid skapande av genererade listor som innehållsförteckning, index, bildlistor, 
etc. används de inbyggda funktionerna för generering av listor i Structured 
FrameMaker. 
1 Välj File > Generate/Book... 

Dialogrutan Generate/Book visas. 
Markera önskad typ av lista/Index. 
I produktionsmiljön finns stöd för: 

2 

• 
• 
• 

Innhållsförteckning (Table of Contents) 
Index (Standard Index) 
Bildlista (List of Figures) 

3 Klicka på Generate... 
En ny dialogruta visas där val kan göras av vilka element och paragrafer 
som ska tas med i den genererade listan. Detta är dock normalt redan 
förvalt (lagrat i malldokumenten). 
Klicka på Generate... igen. 
Ett nytt dokument skapas med en lista på de element och paragrafer som 
har valts. 
Om så önskas, byt utseende på listan m h a malldokument. 
Tillgängliga malldokument för listor finns i huvuddokumentet under 
Försättssidor. 
Komplettera i huvud och fot så att rätt information finns angiven. 

4 

5 

6 
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Attribut Värde Beskrivning 
 "Paneltext" 

 
Används vid benämningar på 
manöverorgan och annan TEXT på 
materiel 

 



4 Malldokument - Titelsida 
En titelsida innehåller information om publikationen som sidan ingår i. En 
titelsida kan vara av två typer: 
• 
• 

för inbunden publikation, med eller utan innehållsförteckning 
för lösbladspublikation med flikregister 

I alla mallar för titelsidor skrivs texten in på mallsidan. Det har gjorts på 
detta sätt för att på ett enkelt sätt kunna generera flera numrerade exemplar 
av en hemlig publikation. 
Titelsidan är obligatorisk i alla bokpublikationer. 
För information om hur hemliga dokument hanteras, se avsnitt 8 
Sekretessmärkning. 

4.1 Ändra flikantal 
Gör på följande sätt för att ändra antalet flikar på ett titelblad: 
1 
2 
3 
4 
5 

Gå över till mallsida 
Dra ifrån respektive lägg till önskat antal rader i tabellen. 
Markera hela tabellen. 
Välj Table > Format > Row Format i huvudmenyn. 
Skriv in ett värde på Minimum och Maximum under Height Limits så att 
tabellen fyller ut hela sidan på höjden (Sidans höjd / antal tabellrader). 
Numreringen av flikarna kan varieras genom att styckeformaten Fliknum, 
Fliknum=0 eller Fliknum=man appliceras på numreringen. 
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5 Malldokument - Omslag 
Malldokument för omslag finns för framsida, rygg samt baksida. 
Malldokumenten innehåller bilder, sparade i Adobe Illustrator format EPS 
med TIFF skärmbildspresentation, för Försvarsmakten respektive Försvarets 
materielverk. 
I alla mallar för omslag skrivs texten in på mallsidan. Det har gjorts på detta 
sätt för att på ett enkelt sätt kunna generera flera numrerade exemplar av en 
hemlig publikation. 
För information om hur hemliga dokument hanteras, se avsnitt 8 
Sekretessmärkning sida 25. 
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6 Malldokument - Försättssida 
Försättssidorna har ungefär samma utseende som motsvarande strukturerade 
dokument för lösblad. Däremot används inte struktur i dessa dokument utan de 
fungerar som vanliga FrameMaker dokument. För den funktionalitet som har 
krävts för dessa har det lagts till önskade styckeformat, teckenformat, 
tabellformat, etc. 
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7 Malldokument – Tryckorts-
/Versionshistoriksida 

Tryckortsidan är obligatorisk i alla bokpublikationer. Det är där delar av 
metadata står som behövs för publicering och registervård. 
Tryckortsidan är baksidan av Titelsidan. 
Tryckortsinformationen bygger uppåt på sidan. 
Sidan med versionshistorik är obligatorisk i alla bokpublikationer. 
Versionshistoriken får dock vid behov finns på tryckortsidans övre del, om 
utrymme finns. Om tryckortssidan är separat följer den tryckortsidan. 
 
Innehållet i tryckortssidan och versionshistoriksidan får inte innehålla några 
säkerhetsskyddsklassificerade uppgifter, information, (även om den har en 
sekretessmarkering).  
Struktur används inte i dessa dokument utan de fungerar som vanliga 
FrameMaker-dokument. 
 

 
  



8 Sekretessmärkning 
I alla mallar är det möjligt att lägga till en sekretessmarkering. Beroende på 
mall och placering ser den olika ut samt hanteras på lite olika sätt. För mer 
information gällande placering, se 19FMV6705-1:1 - Tjänsteföreskrift (TjF) 
avseende säkerhetsskydd och sekretess. 

8.1 Placera/ändra sekretessmarkering 
Sekretessmarkering läggs in eller byts på mallsidorna "Master Pages" genom 
att byta styckeformat på avsedd plats. 

Tabell 12. Val av sekretessmarkering med hjälp av styckeformat 

Säkerhetsklass Sidhuvud höger Sidhuvud 
vänster 

Titelblad, 
Omslag 

KVALIFICERAT 
HEMLIG (KH) 

HEMLIG (H) 

KONFIDENTIELL 
(K) 

BEGRÄNSAT 
HEMLIG (BH) 

Öppen 

hemlig-Liten-TS hemlig-Bred-TS hemlig-TS 

hemlig-Liten 

hemlig-Liten 

hemlig-Bred-S 

hemlig-Bred-C 

hemlig-S 

hemlig-C 

hemlig-Liten hemlig-Bred-R hemlig-R 

Oppen Oppen Oppen 

Hanteringen ovan är framtagen för att lättare få sekretessmarkeringen att 
hamna på rätt plats på respektive sida. 
Den stora sekretessmarkeringen på titelblad och omslag, kräver ytterligare 
modifiering vilket görs på referenssidan där sekretessmarkeringarna är 

 
8.2 Exemplarnumrering 

På hemliga publikationer ska omslagen och titelblad förses med 
exemplarnummer. 
1 
2 
3 

Placera insättningspunkten där exemplarnumret är placerat. 
Sätt styckeformatet till Exemplar 
Tryck på ENTER för att räkna upp exemplarnumret och skapa ny sida. 
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9 Uppdatera dokumentet enligt ny mall 
Ett dokument i FrameMaker kan ges ett nytt utseende genom att importera 
format och andra definitioner från ett annat dokument. Denna möjlighet 
används i mallpaketet för Bokpublikationer då ett dokument med inlaga eller 
försättssida ska uppdateras till en nyare version av ett malldokument. 

1 
2 
3 

Öppna båda dokumenten i FrameMaker. 
Ställ markören i det dokument som ska uppdateras. 
Importera format. 
a 
b
 
c 
d 
 

Välj File > Import > Formats... i huvudmenyn 
Välj dokumentet som formaten ska hämtas ifrån. 
Kryssa i alla val under "Import and Update" 
Kryssa i "Other Format/Layout Overrides" 
Import 

Om dokumentet är av typen inlaga och därmed ett strukturerat dokument, 
fortsätt med: 
4 Importera elementdefinitionerna från malldokumentet. 

a 
b
 
c 
 

Välj File > Import > Element Definitions... i huvudmenyn 
Välj dokumentet som definitionerna ska hämtas ifrån. 
Kryssa i "Format Rule Overrides" 
Import 

Om malltyp ändras vid uppdatering av inlaga, fortsätt med: 
5 Byt värdet på attributet Format i rotelementet Datamodul till samma som 

malldokumentet använder, se tabellen nedan. 

Tabell 13. Attributet Format under rotelementet Datamodul 
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Attribut Värde Beskrivning 

Format 
 

A4ls34n 

A4ls2n 

A4 lösblad 3/4-spalt 

A4 lösblad 2-spalt 

 
 
  

OBSERVERA 
Omslag eller titelblad kan ej uppdateras genom import av 
format utan att förstöra inmatad text då texterna i dessa 
dokument är placerade på mallsidor. 
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Attribut Värde Beskrivning 
 A4hs34n 

A4hs2n 

A5ls1n 

A5hs1n 

A3ls134n 

A4 häfte 3/4-spalt 

A4 häfte 2-spalt 

A5 lösblad 1-spalt 

A5 häfte 1-spalt 

A3 lösblad 1+3/4-spalt 

 


